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VIrDIPAF
ERRE 4 BEE Foy0—k TARTO) T3>
+ STM32CubelDE-DEB STM32CubelDE Debian Linux Installer =25 /0— L alE JC—<53 SRR
+ STM32CubelDE-Lnx STM32CubelDE Generic Linux Installer o L e =] Do AER

+  STM32CubelDE-Mac STM32CubelDE macOS Installer B a e Jl—a S AER

+ STM32CubelDE-RPM STM32CubelDE RPM Linux Installer
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+ STM32CubelDE-Win STM32CubelDE Windows Installer B35S A ERE Jl—a S AER
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Start your software download

Hi ADWN

Please click on this button to validate your email address and start the download of the
requested software:

if you have any further issues, please send your request to our online support using
the subject line: Software download issues.

Thank you
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2. STM32CubelDE D1 >~ X ~—)b

o FOVO—-RUET7AIVEERL, A VA M—SZEEBLET,
Windows 75 5. BEREETRDKSE7 A IVDRITI7AILICIED X T,

; —F7 5 D%,

en.st-stm32cubeide_***.exe.zip st-stm32cubeide_***.exe

T7AIED**BREY T I TP DIN—I 3 VI[CKOTEBEDET,
HREARF exe [FHBFEVD/INY IVDREICKDRRSNIFWVEEDHD ET,

e B Welcome EE

[I STMicroelectronics STM32CubelDE - ®

Welcome to the STMicroelectronics
[N tJ EOUwsLET "I STMI2CubeIDE Wizard
ex v °

life.augmentad
Setup will guide you through the installation of
STMicroelectranics STM32CubelDE.
r- Ttis recommended that you dose al other applications

before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Next to continue.

Cancel

e . 5/{ty1;€ﬁ(‘3 (ﬁm%#gﬁ;@fﬁ'ﬂ) mSTMlcroe\ectromcsSTM32CubeIDE - X

License Agreement
Please review the license terms before installing
STMicroelectronics STM32CubeIDE.

Press Page Down to see the rest of the agreement.

[1Agree] ZO0Uw I ULET,

ETMicroelectronics Software License Agreement
SLADO48 Rev4/March 2018

BY INSTALLING COPYING, DOWNLOADING, ACCESSING OR OTHERWISE USING THIS
SOFTWARE PACKAGE OR ANY PART THEREOF (AMD THE RELATED DOCUMENTATION)
FROM STMICROELECTRONICS IMTERNATIONAL M.V, SWISS BRANCH AND/OR ITS
AFFILIATED COMPAMIES (STMICROELECTROMICS), THE RECIPIENT, ON BEHALF OF
HIMSELF OR HERSELF, OR ON BEHALF OF AN'Y ENTITY BY WHICH SUCH RECIPIENT IS
EMPLOYED AND/OR ENGAGED AGREES TO BE BOUND BY THIS SOFTWARE PACKAGE
LICENSE AGREEMENT.

If you accept the terms of the agreement, dick I Agree to continue, You must accept the
agreement to install STMicroelectronics STM32CubelDE.

<gack Cancel
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O Next] Z7Uv o UET,

O movi—xvroER
© ST-LINK drivers [CF T v I%ZANT
A [Next] Z0UvoULFET,

SEGGER J-Link drivers [, 4 X h—=JLLTHEVE
BADL WIRT2DT/N\y I TO-TZH8HE5TERINEA
VAR=ILARETY,

@ WAV R—ILRT
[Next] ZoUvoULET,

a ERDELIBEXy E—IDRREINDETZTTI,
@ Create desktop shortcut [CF T v IZANTHL &,
TR MY IICYa— MOy MOMERENE T,
® [Finish]l ZZUvoULZET,

[I STMicroelectronics STM32CubelDE - X

Choose the folder in which to install STMicroelectronics m
beIDE

Choose Install Location

STM32Cube

Setup wil install STMicroelectronics STM32CubelIDE in the following folder. To installin a
different folder, dick Browse and select another folder. Click Next to continue.

Destination Folder

Space required: 2.7 G8
Space avalable: 356.8 GB

Browse. 0

(2]

<§am| Next > ' Cancel

[I STMicroelectronics STM32CubelDE - *

Choose Components

Choose which features of STMicroelectronics STM32CubeIDE you m

want to install,

Check the companents you want to instal and uncheck the components you don't want to
install. Click Install to start the installation.

Select components toinstal: | [7] SEGGER Jink drivers

Space required: 2.6 GB

Desaiption

g Posiion your mouse
CIRREG e aver 2 companent to
see its description

(2]

< Back | Install l Cancel

[ STMicroelectronics STM32CubelDE -

Installation Comple te

Setup was completed successfully. m

Completed

Show details

<ok - ——

[I STMicroelectronics STM32CubelDE —

Completing STMicroelectronics
STM3I2CubelDE Setup

STMicroelectronics STM32CubelIDE has been installed on
our computer,

Click Finish to close Setup.

0=

(2]

<§adﬂl Finish l Cancel
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3. STM32CubelDE DF][EfcE)

@ 7o hyTiEERENEY 3 -~y R

Windows X=a—h'5 [STM32CubelDE] ZZIRUEEILE T,

@ 0 Workspace 7« Lo NUERELET.
S CERDKIFNIE Workspace 7« LT RU (&
T I7F IV bDFFTHEWLEEA. Workspace T
LI MUEBEZTBNTLIEEL,

@ [Use this as the default and do not ask
again] [CF T v IZANTHL &, REHRCEIRFIC
DXy E—IFRRENFE A.workspace [,
28, File X— 21— >Switch WorkSpace >
Other... CEETCEFXT,

® [Launch] Z2Uv o ULEY,

E

STM32CubeIDE***

[ STM32CubelDE Launcher

Select a directory as workspace

STM32CubelDE uses the workspace directory to store its preferences and development artifacts.

Workspace: | G#Users¥win10¥Documents¥projects¥STM32CubelDE | [ Browse.

10

(2]

[ Use this as the default and do not ask again 9

el

[FIRKIETICRIT 28] DRRSNET . ZHIRBIEERNRT —57% ST YA JOHDINET ST

EICAETDANEDIHNTIN., T TIF[OK] UEXRFE A
#CEN%. Window X—1—> STM32Cube > End User Agreements CTEE I DT ENTEET,

[ Features Usage Statistics Agreement

(2]

Help STMicroelectronics improveits products.

purpose of continuously impraving the application.

preferences via the menu
Window > Preferences > STM32Cube >End User Agreements

For details please see our Privacy Policyl and Terms of Use

STint N.V (a5 data controller) collects and uses anonymous features usage statistics (directly o by ST affiliates) when you use the application for the

You can stop the collection of your features usage statistics when you use the application at any time with effect for the future or update your
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O THEO&L 5% Home BENFRENES, —B STM32CubelDE #£7 LFT.

[T STM32CubelDE - STM32CubelDE - o x
File Edit Source Refacior MNavigate Search Project Run Window Help
5 Information Center % oy A= s
Bl @ sszcubeine Home ~
Start a project
Support & Community
Welcome to STM32CubelDE

What's new

B Lh,
CubelDE

Example Selector

cting the most == = 1 1= v
mr S = : P = % Standalone STM32 Tools

crt with
@ sTM32CUDeMX
32Cu

’ How to access it : File > New > STM32 Project > Select Example Selector Tab

3200
® 3200
Quick links <81

| © STM32CubelDE resource portal on wiki |

| 3 sTM32 videos |

$TM32CubelDE manuals |

BTHRIA705T
O [Always exit without prompt] [CF T v IZANTH L EREREEFIFICC DS 1 7OTERREINE H Ao
O [Exit] #OUvIULFET,

[ Confirm Exit X

@ Exit the STM32Cubel DE?

[ Always exit without prompt
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@ Windows m5T5270—-5—T. Workspace 7« L& hUIZ. $YTILY—2 [AKM-2102_
SampleSource.zip] Zf#&R U T TE e [mecanum-sample] 7 # L5 ZBEULE T,

8 STM32CubelDE - o x
m-h ®E EE (7]
E o = R 741 I [E~ O ®8Fry9 fiv7A V_
o < E PA T Ryl 1 TP NEREF o
F-ay BNER |, '
fits T BLIr )
RAY REOL- =
B -
< v 4 > PC s FFIAUE > projects » STM32CubelDE » v B o STM32CubelDED.
&0 - gE #13
Jaciadata szl
mecanum-sample 5/25 11:51 TN TRNA- ]
EDEE 1 E0ESTER =

e [mecanum-sample] 7% JULFW®D .project 77 IS TILo U I LTRELET

mecanum-sample

- [m] X
PR °
I [E- O BEFryY fivIA
ey I
NER o)
T E
FEEO-
STM32CubelDE > mecan v o O mecanum-sample..
£ #4X
settings
Core
Drivers
User 7
[7] cproject [« 26 K8
| Lmsproiect 20220493 1730 MXPROJECT 741, KB
[iH project 2022/02/28 16:46 PROJECT 771 )l 2 KB]
TECanuT SampIEIoe e v oo pEg:
[] mecanum-sample.launch 023/0 A 9KE
README.md MD 774 )l 7KB
[ STM32L4AEZGTX_FLASH.Id LD 771l 5KB
[ ] STM32L4AGZGTX RAM.Id LD 774l 5KB
2EAOEE  1EOEEEER 1.16K8 =



https://www.adwin.com/image/support/AKM-2102_SampleSource.zip
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AXAF Lk —IOR

FFEREDIEE

e 7OV I MMIA VIR— MDEIT D EUTOX Yy E—IDRRENF T,
[OK] ZOY v I ULTXAyE—IZHAUET,

[ Project Explorer
S-3
[ mecanum-sample

[ sTM32CubelD
File Edit Source Refactor N ate
il [®~-R-E@iw

v

[N~ R R RACRSE 2 RS el K s

Search Project Run Window Help

4B E nid - Fl-n

= B [{3READMEmd X =
8 1 & LA =N HU2N 05 L(LeA6T6R) @
3 LA - DY A0S L NUCLED- LARGZGRII T T .
4
5 EhFEDEEEIELEGOT. UART2REFUARTSNGOANIE LT, MRS FETOE T,
s
7 ik, UART2, UARTSC O 22 083 L TEOENET0 - R (RTS/CTS) (Tl
8
9 % T-HOEhIHETD
10
[T Operation completed... X s
LA

Successfully imported the project 'mecanum-sample into the workspace.

- o X

R fndl )
Q | E
8 %0u. X @Bu. = O

o=

There is no active editor that
provides an outline.

28
21 ss# UART20DEHVEYES
22
23 UART2(ZZTF('e’~'9" (ex3e~ex30) WA, A~ 1 HELET,
24
25 #ss T-HENECERD
26
27 UARTC *m' (anAM M A NHE~20S. F M ees b Hlrs & TR T st 2ewe Y
< >
[£] Problems X J£ Tasks [ Console [ Properties = O [z Build Analy.. X Static Stack... (@) Cyclomatic.. = O
T 8 [ ]
0items
Description Resource -
Mermory Regions | Memory Details|
Region Startaddress  End address Size
< > < >
Writable Insert [1:1:0
H o i - el
e [Project Explorer] T7OY 1O b I 7 A ILZREUCRDTENTERT,
[ STM32CubelDE - mecanum-sample/User/Inc/motorh - STM32CubelDE - O X
File Edit Source Refactor Navigate Search Project Bun Window Help
(i} < | B-R-EBividi@-S-E-F-iH-0- Q- ™I JRE -G -T2 @
Q s ||@
(5 Project Explorer % = B | [{READMEmd  [A motoch x =8 Zou.x @B. = 8
BS T § 1 kifncjef MOTOR_H ~ ISIER IR
v [T mecanum-sample ; #define MOTOR H # MOTORH
.
) Includes 4 #include "main.h” H - mainh
(2 Core N @ (anonymous)
(2 Drivers 5 4 E-nE @ MOTORN: enun
v (8 User 75 typedef enum { ++ motor_init(TIM_HandleTy|
~ (= Inc 8 HOTOR 1 = 8, ++ motor_enable() i
8 bmx0ss.h a HOTOR_2, £+ motor_disable() : void
[6 motorh 18 HOTOR_3, 4 motor_fore_pwm(MOTOR
[ sample.h i; \é’g;”# ++  motor_back_pwm(MOTO
= motorh.bak s } MOTOR_nj ++  motor_pwm(MOTOR_n, 7|
[E sample.h.bak 12 /7 E—B0RL ++ motord_test{int(], uint8_t)
~ = Src 15 void motor_init(TIM_HandleTypeDef *p_htim); kad
[ bmxoss.c 16 o
£ motor.c 17 /7 TR0, Ehik +
8 samplec 15 void motor_enable(); £+ motor_checkl
19 void motor_disable();
20
[ mecanum- sampleioc 21 // E—Bmotor iM% pum_fval=e.8~1.0TERE. R st%c_val=[0,1]TERE.
p e 22 int motor_fore pwum(MOTOR n motor_i, float pwm fval, int c_val);
mecanum-sample.Jaunch 25 int motor_back_pwm(MOTOR_n motor_i, float pwm_fval, int c_val);
[y READMEmd 24
[g STM32L4ABZGTX_FLASH.Id 255 /) E—Smotor_il#Tié FEY N %pwn_fore_val, pwm_back=0.8~1.0T4E.
[ STM32L4AGZGTX RAM.Id 26 // &#L. pum_fore_val,pwn_back valdufi(rt—A(1e. e2%(T1. eTHHNIASSEL
27 int motor mum(MOTOR n motor 1. float nwm fore fual. float nwm hack fua
< > < >
[ Problems x JZ| Tasks [ Console [ Properties = O[5} BuildAnaly.. X z2 Static Stack.. (@) Cyclomatic.. = 5
v 8 o8
-
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@ NUCLEO k— RDF/ty 13/ USB F& PC ZEELET,
LD4 h'#<. LDB HMRICRIIT BT & ZRRLET.

FFEREDBE

8 sTMz2CubelD anum-s ser/Inc/motorh - STM22C — O x
File Edit Source Refactor Navigate Search Project Run Window Yaelp
(] 2 [ B~Q-@inidi @@ O-QA~-®y-[HRE T H-Fro> oo O
Q g
5 Project Explorer x = O [¢j READMEmd [B] motarh X = B EOu.X @Bu. = 8
ES Y 8 L #ifndef MOTOR H -~ %R o %
~ [ mecanum-sample 2 #define MOTOR H # MOTOR H
P g; N M |
35, Binaries 4 #include "main.h" & mainh
@l Includes 5 @ (anonymous)
& Core R @ MOTOR.n: enum
8 Drivers £+ motor_init(TIM_HandleTy
« G8 User [I3 Confirm Perspective Switch ¥ motor_enable):void |
v = Inc £+ motor_disable()  void
[ bruoss.h ) This kind of launch is configured to open the Debug perspective when it suspends. £ motor_fore pwm(MOTOR
[8) motoch e Do " . R— § £+ motor_back_pwm(MOTO
is Debug perspective supports providing views for
5] sample.h displaying the debug stack, variables and breakpoints. £+ mator_pwm(MOTOR.n, fi
|2 motorh.bak ¥+ motord_test(int[], uints_t)
|2 sample.h.bak Switch to this perspective? + motor_testo() : void
& Src ++  motor test1():
@ Debug [ Remermber my decision 0 £ motor_test2():
[ mecanum-sample.ioc ++ motor_check() : void
B mecanum-sampleJaunch ' No
[y README.md )
4 T e e e —var=Te; TR,
5 STM32L4AGZGTX FLASHd 22 int motor_fore_pum(MOTOR_n motor_i, Float pwn fval, int c_val);
(3 STM3ZL4AGZGTX RAM.Id 23 int motor_back_pwm(MOTOR_n motor_i, float pwm_fval, int c_val);
24
259 // E—Bmotor_i)§i i FERL 1% pwm_fore_val,pwm_back=@.9~1.8TERE,
26 // Rl pum_Fore_val,pum_back_vald)I b1, o3 L. OTHIIEEN
77 dnt motor owm(MOTOR n motor i. float mwm fore fual. float nwm hack fua ¥
< > < >
2l Problems 42 Tasks & Console X [[]Properties = E [ Build Analy.. X 22 Static Stack.. (@ Cyclomatic.. = B
P ) y = y
|IBREEREE e85~ = 3
r;\ecénum;i:mple[:T:ﬂESIZUC**A Ipic: 12] leclf - / ple/Debug -
evice : ex s S
Revision ID : Rev 2.@ EIEN I
Device name : STM32L486xx/STHM32LAAGKX Memory Regions | Memory Details
v Region Startaddress  End address Size O
< > < >
Writable Smart Insert [1:1:0 T 0] 1%

JOJSLDEI RBRTEN, LIESKTHELRDA Yy E—IDHRRENET T,
FTINVIN=ARGFT 4T (FNYIRI v I BEH BROTV—IRAY hERRT BlcbDE1—)
[CUIDBRBEESIHZ-ESIBDTIH. @ [Switch] 27U v I ULTYIDEXFT,
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FRRREDREE

© VI AROF 4TI BD I,
TOY5LERTIBICEY—)LI—h'5 Resume REVEI U v I LET,

[

[T STM32CubelDE - mecanum-sample/ Rl Sre/main.c - STM32CubelDE

File Edit Source Refactor MNavigsjedSearch Project Run Window Help

=R |Gig-in|Wm)mrsoe.ilsiidib-0- %o s - H-§H-e

3 Debug X [ Project Expl...
B k| § 2a1s
~ [[I] mecanum-sample [STM32 C/C++ Applic ¢
v {8 mecanum-sample.clf [cores: 0]
v (@ Thread #1 [main] 1 [core: 0] {Susp
= main() at main.c:125 0xB000f72
pi] arm-none-eabi-gdb (10.2.90.2021062
35 ST-LINK (ST-LINK GDB server)

= B [{READMEmd  [B motoch  [§ mainc X =8
HAL_Tnit(); ~

/* USER CODE BEGIN Inif */ Name

/* USER CODE END Init */

/* Configure the system clock */
systenClock_Config();

/* Configure the peripherals common clocks */
periphCommonClock_Config();

EGIN SysInit */

sysInit */

/* Initialize all configured peripherals */
MX_GPIO_Init();
MX_LPUART1_UART Init();
MX_USB_OTG_FS_PCD_Init();
MX_ADCL_Init();
MX_CANL_Init();
MX_DACI_Init();
MX_T2C2_Tnit();
HX_USARTL_UART Init(};
HX_USART2_UART Init(};
MX_USART3_UART_Init();
MX_SPI1_Init();

< >

@ Console X [2] Problems (3 Executables [§3 Debugger Console [J Memory

mecanum-sample [STM32 C/C+ + [pid: 12]

ta .

Type

=V X ®gB &TE
X

- o x

M=aN i ]

Q iE| B

MR % = O

e et §
Value

= a8

% % | B bl M@ @ -9~

Download verified successfully

Writable Smart Insert 125:1:3614

-~

FINy IZEIETBICIFY—IVIN—H'5 Terminate RYVZ O U v I ULET,

TNy IZFBIELTETOTSLRBRTZRIIERT . Ffe. TOTSLRBTEREATVICETIATNT
WBDT. NUCLEO R—RZUty hUTD. EBRZANELCHEETIOI S LADRITENET,

[
Ll

[T STM32CubeiDE - mecanum-sample/Core/Src/\lin.c - STM32CubelDE - u} X
File Edit Source Refactor Navigate Sear roject Run  Window Help
e | B -in| B o t e 2| S RS-0 - @Sl O
Q ||
ug X K roject Expl... e motor main.c X M=V X S " Rty 2
Debug Project Expl, = O [} READMEmd h i =0 V X 9B &TE HUR =0
B [ 3 gs | HAL_Init(); ~ 2 IEll= =
~ [ mecanum-sample [STM32 G/C++ Applic 20 50 o con cons gEGTH Tnit =/ Name Type Value
v &8 mecanum-sample.elf [cores: 0] 128 it
#® Thread #1 [main] 1 [core: 0] (Runr 129 /* USER C1 END Init */
pii arm-none-eabi-gdb (10.2.90.2021062 130
W5 STLINK (ST-LINK GDB server] 131 /* Configure the system clock */
132 SystemClock_Config();
133
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@ File x=2— > New > STM32 Project Z&IRLF T

[ STM32CubelDE - test/Core/Src/main.c - STM32CubelDE - [m) x
File | Edit Source Refactor Navigate Search Project Run Window Help
New Alt+Shift+N > [6] Makefile Project with Existing Code =dN i ] Q | |RE%m
&l | G = O E=Outline X @ BuildTargets = O
€3 Open Prjectsfrom File Systemn. ST 32 Project B : : N SRS o M E
Recent Files. > [0 STM32 Project from an Existing STM32CubeMX Configuration File (.ioc) it
Close Editor crisw | Project. hlpuart1 ; UART HandleTyp
. pay . hped_USB_OTG_FS b pel
Close All Editors Cul+ShiftsW | &9 Source Folder oymemCiock Confiatvord) o
Cuies |3 Folder - and the Systick. */ MX_GPIO_Init(void) : void
[, SaveAs. lef Source File MX_LPUART1_UART nit(void) : void
B Savelll G 57 Header File MX_USB_OTG_FS_ PCD.Init(void) : voic|
File from Template main(void) : int
" SystemClock_Config(void) : void
@ Class
MX_LPUART1_UART_Init(void) : void
Other. MX_USB_OTG_FS_PCD.Init{void)
. = MX_GPIO_Init(void)
9 Board Selector ¥ 7%= Uw I LE T,
N )] N ~ “ W —_ - “
BH. YIEIEUTDD 1 Y RODKRREND T TREADHDDFT .
[3 sT™32 Project m] X
Target Selection
i), STM32 target or STM32Cube example selection is required
MCU/MPU Selsctor
MCUMPU Fil
R B o Features Black Diagram Do AD Resources Bu
o)
Part Number
a +-
PRODUCT INFO v
Segment >
Series >
Line >
Marketing Status >
P > fmce
New STM32H5 MCU series: more
Package > performance & scalable security
Core >
Coprocessor >
MCUs/MPUs List: 3776 items Display similar items ™ Export
|- [ Pario | Reference |Marketing . XJunitPrice f..X| _Board _X|
MEMORY wazcgt STMIZCU1-.. Coming soon NA WLCSP 12, 32 kBytes 6 kBytes  STM32C011D6Y3TR 1
Flash From 0 to 4096 (kBytes) % 7 STM32C01.. Active 0.5503 WLCSP 12, 32 kBytes GkBytes  STM32C011D6Y6TR
@ " e STM32C01.... Coming soon NA TSSOP20 16kBytes G6kBytes  STM32CO11F4P3
% grzacer, STMIZCOT.. Active 0.5363 TSSOP-20 16kBytes GkBytes  STM32CO11F4P6
EEPROM_From O to 16384 (Bytes) % 7 §TM32C01._. Coming soon NA UFQFPN 2 16 kBytes  6kBytes  STM32C011F4U3
0 16384 % STM32C01.... Active 0.5353 UFQFPN 2 16 kBytes 6kBytes  STM32C0T1F4USTR
RAM Total From 2 to 2514 (kByles) % STM32CO01.... Active 0.7013 TSSOP20 32kBytes GkBytes  STM32CO11F6P3
L vy % STM32CO1... Active 0.7013 TSSOP20 32kBytes GkBytes  STM32CO11FGPITR
2 2514 % STM32C01__. Active 06098 TSSOP-20 32KkBytes 6kBytes  STM32CO11F6P6
RAM From 2 to 2514 (kBytes) Y STM32C01___ Active 06098 TSSOP-20 32kBytes 6kBytes  STM32C011F6PETR
2 2514 % STM32CO1.. STM32CO1.. Active 0.6524 TSSOP-20 32kBytes GkBytes  STM32CO11F6PT
CCMRAM From 0 to 32 (kBytes) % STM32CO1... Active 0.6524 TSSOP20 32kBytes GkBytes  STM32CO11FGPTTR
[, * % STM32C01.... Coming soon NA UFQFPN 2. 32 kBytes 6kBytes  STM32CO11F6U3
0 32 — ——— - e
< Back Next Finish




XAFLika—=bOKRY b AS

FRRREDREE

© xHFLkr—LORy MCRATNTVSOE NUCLEO-LAABZG) TF .
[Commercial Part Number] #(C. [LAAB] EARNTNIEHHIRONFE T D THEEEERIRLTL

ZEL,
[I5 sT™32 Project o
Target Selection
i) STM32 target or STM32Cube example selection is required
Board Selector
Board Filters
[‘a = o tures Large Pict K t E
Commercial
Part Number e
INUCLEO-L4A62G |
Q o =
PRODUCT INFO ~ I .
Type
\aE T
O 0 =Enif—RESUYSL. @ Next] ZUwsLET,
[3 sT™32 Project o
Target Selection
Select STM32 target or STM32Cube example
Board Fil N
[‘:ra @ ) Features Large Picture Dacs & Resources [ patasneet ] Buy
Commercial STM32L4 Series
Part Number INUCLEO-L4ABZG *
STM32 Nucleo-144 development board with STM32L4A62G MCU, supports
EO-L4ABZG . .
Q + - Arduino, ST Zio and morpho connectivity
PRODUCT INFO v Part Number : NUCLEO-L4AGZG UnitFrice (55):19.0
Product s in mass production Commercial Part Number : NUCLEQ-L4AGZG Mounted Device - STU32L4A62ET6
Type >
Supplier N The STM32 Nucleo-144 board provides an affordable and fiexible way for users to try out
Po new concepts and build prototypes by choosing from the various combinations of
MCU / MPU Series > performance and power consumption features, provided by the STM32 microcontrolier. For
the compatible boards, the internal or external SMPS significantly reduces power
Marketing Status > consumption in Run mode.
- N The ST Zio connector, which extends the ARDUING® Uno V3 connectivity, and the ST
e morpho headers provide an easy means of expanding the functionality of the Nucleo open
development platform with a wide choice of specialized shields.
The STM32 Nucleo-144 board does not require any separate probe as it integrates the
MEMORY ~

ST-LINK debugger/programmer.

The STM32 Nucleo-144 board comes with the STM32 comprenenswe free software libraries
Ext. Flash =0 (VBit)

and examples available with the STM32Cube MCU Package.

L
0
Ext. EEPROM = 0 (kBytes)

L
0
Ext. RAM = 0 (MBit)

L
0

Boards List: 1 item M Export
FEATURES ~

Embedded Senser >

User Button > % I NUCLEO-4ABZG  Nucleo-144 Active 190
Camera >

CAN >
Connector >

@ <Back l Next > ' Einish Cancel
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6 O Project Name #(CEZERF7ZATILT BINextlZo U v
JULET,
Options & & W RBEEDRE [CRIEK(FNE [Finish] 2O U w
JUTHBVE A,

6 [Next] ZoUvo93E F47OTABFERRICEDTT,
BEIREHEINE [Finish] ZUvILET,

FFEREDBE

[ STM322 Project o X

Setup STM32 project

Project
Project Name: &t
Use default location

Location: C:/Users/win10_nagao/Documents/projects/STh32Cube| [Browsen
Options.

Targeted Language

@®c O+

Targeted Binary Type

(@ Executable (O Static Library

Targeted Project Type
@ STM32Cube O Empty

(2]

[ sTM32 Project o X

Firmware Library Package Setup
Setup STM32 target's firmware

Target and Firmware Package
Target Reference: NUCLEO-L4AEZG

Firmware Package Name and Version: STM32Cube FW_L+

Firmware and Software Package Repository
Location:
Ci¥lUsers¥win10_nagao¥STM s2Cube¥Repository

See Firmware Updater’ for settings related to package installation

Code Generator Options
O Add necessary library files as reference in the toolchain project configuration file
Copy all used libraries into the project folder

@ Copy only the necessary library files

@ [ <Back Meis [ Enish ]} concel

A 70V 1Y MEREHRCHERSY 1 70 hH<BEGF. AEZHESEL Yes] b [Nol
ZOUw I ULTLKIEEW, EE5DDHSRFVEEEFT T4IL hD [Yes] THEULEE .
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@ =Y TRYIF Y s—UESYYO—-RLTVET.
TMHTOBER— REBRLTOTOY 15 MERIZD UBEH DD T,

[ STM32 Praject m]

Firmware Library Package Setup
Setup STM32 target's firmware

Target and Firmware Package
Target Reference: NUCLEQ-LaA6ZG

Firmware Package Name and Yersion; STM32Cube FW_L4 |V1.17.2

Firmware and Software Package Repository
Location:
C¥Users¥win10_nagac¥STM32Cube¥Repository

See ‘Firmware Updater’for settings related to package installation

Code Generator Options
Add necessary library files as reference in the toolchain project configurati
Copy all used libraries into the project folder

Copy only the necessary library files

Perform Project Creation. Please Wait For Completion ..

Download File stm32cube_fw_l4_vi170 zip

482.4 MBytes / 723.0 MBytes (

Download and Unzip selected Files

OK Cancel

@ < Back Next > Ereh Cancel

@ JOVzI MEBNETI2ELREDY A 7OIDEUTET 7 M ERETEDRECED XTI,

- o x
Q | @0
=a

va

[T STM32CubelDE - Device Configuration Tool - STM2CubelDE
File Edit Nevigate Sesrch Broject Run Window Help
B-HRB-R - Bidis-0-%-iFf- - -F-0Fe-0- @
BProje. x = 8 [RBm [€) stm32kx_hal dma.c [ testioc X
CEEREN ot Pinout & Configuration
> [ blink_Fa4sZE
> [ blink LsAez Pinout & Configuration Clock Configuration Project Manager
> [ mecanum-sample
[ et Software Packs
> ) Includes
e C— ]
& STM32L4AGZGTX,
[ STM32L4ABZGTX, System Core >
[ testioc
Analog >
Timers >
Connectivity >
Multimedia > _—
Security >
Computing >
Middleware and Software Pac... >
STM32L4A6ZGTx
ra
@ o oa @ 4 Qf
< >
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FFEREDBE

0 ER LIc 70Oy 2 hD Core > Src > main.c ICZ7O0J S L%EERL. Lok [LFH] BESEBTH

FL&Do

I STM32CubelDE - test/Core/Src/main.c - STM32CubelDE - o X

File Edit Source Refactor Novigate Segrch Project Bun Window Help

[milg [B-RA-@Binidi@ - @-F-@-i%-0-Q- O I-[JRETH-F-C7C Q

—_— —

By Project Explorer x E G 7 8 = O [[@ mainc X [@ stm32dochalvarte [ testioc =
[ blink_Fd467E 1 /* USER CODE BEGIN Hehder */ ,.
I3 blink_L4AeZ 2/

[} mecanum-sample 3
VI test a @file main.c
y H @rief Main program body
4 Binaries .
& Includes 7 @attention
v (8 Core s N
@ Inc 2 Microelectronics.
~ (= Src 10
ma 11
Tmttbo_hal_mep.c 12 This software is licensed under terms that can be found in the LICENSE file
[ sm3hes it 13 in the root directory of this software component
14 If no LICENSE file comes with this software, it is provided AS-IS.
@ syscalls.c -
6] sysmem.c o
[€] system _stm3zldxx.c 17 /
(= Startup 189 /* USER €O ND Header */
(3 Drivers 19 /* Includes - -- /
= Debug 20 #include "main.h
[ STM32L4AGZGTX FLASH.Id 21 X )
[3 STM32L4AGZGTX_RAM.Id 228 /* Private includes ----
23 /* USER CODE BEGIN Includes */
[@ testioc b
21 test Debug.launch 35 /* USER CODE END Includes */
26
276 /* Private typedef --
28 /* USER CODE BEGIN PTD
29
30 / /
31
328 /* Private define --- /
33 /* USER CODE BEGIN PD */
34
35/ /
36
379 /* Private macro -- /
38 /* USER CODE BEGIN PM */ vl
[#] Problems | Tasks [ Console X [ Properties = > = O [qBuildAnalyzer X 2= Static Stack Analyzer () Cyclomatic Complexity ®? 3§ =0
okosue(iodepiaylahiieine test.elf - /test/Debug - May 31, 2023, 5:30:05 PM
Memory Regions| Memery Details
Region Startaddress  End address Size Free u
EEHRAM 0%20000000 Ox20045FFF 320 KB 317.06 KB 2
EHRAM2 0x10000000 ox1000ff s1K8 s1K8 o
Ox0B000000 O OBOFFFF 1024 KB 1009.26 KB 1
< >
‘Writable Smart Insert 1:22:21
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e main.c @IXY k@ /* USER CODE BEGIN 3 */ h'5 /* USER CODE END 3 */ OEICITD
J—PRZEEELE T,

105
106
107
108
109
110
111
112
113
114 3}

/* USER CODE BEGIN 3 */
HAL_Delay(500);
HAL_GPIO_WritePin(GPIOB, GPIO_PIN_7, GPIO_PIN_SET); //LD2 % =T
HAL_GPIO_WritePin(GPIOB, GPIO_PIN_14, GPIO_PIN_SET); //LD3 Z =T
HAL_Delay(500);
HAL_GPIO_WritePin(GPIOB, GPIO_PIN_7, GPIO_PIN_RESET); //LD2 Z;H¥T
HAL_GPIO_WritePin(GPIOB, GPIO_PIN_14, GPIO_PIN_RESET); //LD3 Z ;8T
L
/* USER CODE END 3 */

O - rrEmTEESEFLTHTREL,
500msec $#(C LD2 & LD3 Zmila iR Y & 31>z TL& S h.

LD1 ZfEE3(E. ioc T7AILEBWT PC7 EV% [GPIO_Output] (CEREUL.
DI — RZERg 2B SHDFET,

HAL_GPIO_WritePin(GPIOC, GPIO_PIN_7, GPIO_PIN_SET); //LD1 % =5i/T

HAL_GPIO_WritePin(GPIOC, GPIO_PIN_7, GPIO_PIN_RESET); //LD1 Z;H¥T
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8. 1In tion Center

o Help XZ=1— > [Information Center] ZET&X I,

[T STM32CubelDE - mecanum-sample/Core/Src/main.c - STM32CubelDE

File Edit Source Refactor Navigate Search Project Run Window | Help

[ | W& ~@ieid @~asv [~ @~ 1) Information Center
2 Project Explorer % BGY § =0 [@mincx | O Vdeotuorils
[ blink_Fa462E 25 HAL (7) Help Contents
[I1] blink_L4A6Z 2 ;

[3 mecanum-sample

% Search

12
1
1
1 Show Context Help
1
1
1

Show Active Keybindings...
51/
3 Syedn TpsandTricks.
Cheat Sheets...
per @ Eclipse User Storage

Cerl+Shifts L

© coEmENS STM32 [T BRLHERICT I A TERT,

- o X
Q i |4
EE Outline X (@) Build Targets =8
Bl 1% W o % 3
@  htim@: TIM_HandleTypeDe ~

® hped_USB_OTG_FS: PCD_Ha
#  SystemClock Config(void) : voidl
f+ PeriphCommonClock_Config(void)
45 MX_GPIO_Initivoid) : void

45 MX_LPUART1_UART Init(void)

F1S MX_L 1G_FS_PCD_Init(void)

[ STM32CubelDE - mecanum-sample/Core/Src/main.c - STM32CubelDE
file Edit Source Refactor MNavigate Search Project Run Window Help
& ([ Information Center X

B

TM32CubelDE Home

Start a project

% What's new

®
Quick links

53]

e New STM32H5 MCU series: more
project performance & scalable security

Welcome to STM32CubelDE

R | @ STM32CubelDE resource portal on wiki
‘example

$TM32CubelDE manuals

| B 5TM32 videos

| W STM32 MPU wiki

| W $TM32 MCU wiki

| () sT™™32Cube github

B &A=

@ Support & Community

Commitment

b
@ Standalone STM32 Tools

@ sTM32CubeMX
@ stvazcu
@ sTv3zcy




